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 Media Development Room Procedures and Rules

Eligibility for Using the Media Development Rooms
To use a Media Development Room, you must be a Douglas College student or employee with a 
current Douglas College ID card. 

Booking the Media Development Rooms
There are two Media Development Rooms, room 3144 in New Westminster, and room B1251 at 
David Lam. To book an editing station in a room, go to CEIT  room 3100 at New West or CEIT 
room B1250 at David Lam. You may book a station up to a 4-hour time block. If you do not 
arrive within the fi rst 15 minutes of your start time, your station may be given to another user.

Training
Employee Workshops: Employees can request a 2 hour workshop. 

Student Orientations: Faculty can book a 1 hour orientation to video editing for their students. 
           The Media Development Rooms are for Douglas College projects only.
To book training, call the CEIT Help Desk at 604-527-5330.

Hours of Operation
The Media Development Rooms are available during CEIT operating hours, 8:30am to 4:30pm. 
Outside these hours, you may access the rooms by showing a valid employee or student ID card 
to Security. Security will provide access.

 Regular Hours (Both Campuses)

 Monday to Friday 8:30am to 4:30pm
 Saturday and Sunday Closed 

 Outside Hours 

 New Westminster Campus
 Monday to Friday 4:30pm to 9:30pm
 Saturday and Sunday 7:00am to 7:00pm
  
 David Lam Campus
 Monday to Friday 4:30pm to 9:30pm
 Saturday  8:30am to 5:30pm

Equipment
- Each room has three video/audio stations for digital video editing, and one graphics station 
   with scanner and printer. Memory card readers, for cards such as SD cards, are installed in 
   each computer. 
- MiniDV camcorders for capturing video footage can be signed out through the Library.

Continued next page
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 Media Development Room Procedures and Rules

Technical Assistance
Check the Douglas College Digital Video Editing User Guide.
During regular hours: At New West, request help at the front counter of room 3100.     
      At David Lam, room B1251, call the Help Desk at 604-527-5330.

Backup Media Files
Users are responsible for the back up of all project fi les. 
CEIT does not back up editing stations. All video fi les will be deleted the end of each semester.

NOTE: 
You must use the same editing station to access your previous fi les. 
Or, back up all your fi les each time on your personal USB drive. 
(We recommend at least 32 Gb size USB drive.)

Please have consideration for others: do not unplug or change the edit suite cables.
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Open Editing Software

OOn desktop, double click on icon  “Vegas Movie Studio Platinum 9.0”  

                                                            Getting Started

Steps To Begin an Edit Session
 1. Turn on the TV, VCR, and computer monitor. 

 2. Set the VCR Input Select to L1 (Line 1).

 3. Turn on the computer and log in.

Login Procedure
There are three video editing stations. Each one has its own login: station1, station2, station3.  
         
First Login:

 Username:  station1
 Password: (No password)

       Workstation only

1. New Project Window opens.
 2. Name your project under Project Name. 

 3. Select Browse button and select station1 (F:)

 4. Select OK.
     You have named your project and created its folder on the F: drive.
 5. Show Me How dialogue box opens, select Close.
     You are now in the Vegas main editing window.
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Vegas Orientation
 Main Editing Window naming key areas of the software
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Vegas Orientation

Main Editing Window

Vegas opens automatically 
displaying the main editing 
window. This window con-
sists of three primary areas. 
The Track header and Time-
line are in the lower half of 
the window, and the Windows 
Docking Area in the upper 
half. Start by familiarizing 
yourself with these areas of 
the Vegas screen. As with 
most Windows programs, 
there is a Menu Bar under 
the title bar containing menu 
items such as Project, Edit, 
View, etc. 

Toolbar
There is a Toolbar immediately below the menu bar. The toolbar contains shortcuts to 
frequently used options.

Window Docking Area
Below the Toolbar is the Window Docking Area. Several windows are arranged in a tabbed 
format. The tabs are located at the bottom left area of the screen. The Window Docking area 
holds your commonly used features such as Project Media, Preview Window, Media Genera-
tor and Audio levels, which you access by clicking the appropriate tabs.
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 Track List
   The Track List area defi nes the order of the video and audio tracks in your project and        
   contains controls that will effect the entire track. 

   Vegas automatically gives you 6 tracks when you open a new project.

Timeline
       Arranging and editing is done in the Timeline. This area contains the video, audio,    
          stills and titles that will appear in the show you are creating. The Timeline offers vertical  
          and horizontal + and – buttons, which are located near the bottom right-hand corner of   
          the Timeline.

   

   1.  Use the vertical + and – buttons  to enlarge or shrink the size of the image in the Timeline. 

   2.  Use the horizontal + and – buttons  to increase or decrease the amount of video time 
you see on the Timeline. These buttons also allow you to adjust the size of the working 
area. You can zoom out to see everything on the Timeline at once, or zoom in to the area 
that you are currently working on.
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Master Audio Levels
 Beside the Windows Docking Area is the Mixer Window, 
 where you can view your audio levels (click on Mixer tab).
 Final audio adjustments are made here before you export 
 your project to tape. Setting should be around 18. 

Preview Area 
 The Preview Area screen shows the video being played
 from  the Timeline, Trimmer, or previews video played 
 within the Explorer or Project Media windows.
 Here you can:
 1.  Save a frame of video as a still image.

 2. Select Preview on External Monitor button to 
     see your video on the TV.

Camcorder
Connecting MiniDV Camcorder or VCR

 1. Power the camcorder or VCR by plugging the AC adaptor into the wall power outlet and
 into the camcorder or VCR.

 2. Plug the small end of the fi rewire cable (4-pin) into the camcorder or VCR. (You will fi nd  
the fi rewire cable on the editing suite desk, one end already connected to the computer.)

Loading MiniDV Tape in Camcorder 
The camera used in these illustrations is a Canon ZR60.

 1. Provide power to the camcorder.

 2. Slide open the Open/Eject lever located on the bottom of 
 the camera.

 3. Fully open the door until it clicks. The tape       
     transport mechanism opens automatically.
 4. Load MiniDV tape gently into cassette holder  

 with tape window facing up, i.e., the tape take-
 up spools must face the white spindles inside 
 the tape transport mechanism.

 5. To load tape into camera, press down on the   
 black bar on the word PUSH. See photos. Wait   
while the camera automatically inserts the tape. 
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Do not force this.

6.  Push the door closed.

Capturing

Capturing Video from MiniDV
Before editing can begin, there must be video 
images in the computer. The process of getting 
the video from tape into the computer is referred to as capturing the 
video. A video fi le in Vegas is an “.avi” fi le. (A still image fi le is typi-
cally a “.jpg” fi le.)

1. Connect the camera to the computer with a fi rewire cable (the one 
with a four-pin plug) and set the camera to Play VCR.

2. If the Digital Video Device dialogue box opens, select Cancel.

3. On the menu bar click Project and select Capture Video. A 
dialogue box appears Capture Video, select DV, then select OK.

4. The Verify Tape Name dialogue box appears. Name your tape by 
typing into the File name box, for example, Tape 01.

5. Below the tape name, select the fi rst option: Don’t capture any 
clips right now. To manually start and stop the capture, click OK.

6. Click Play on the Video Capture controls and fi nd the beginning 
of your fi rst clip. Roll back about 10 seconds, if necessary, rewind 
tape fi rst.

7. Press the round Capture Video button at the bottom, left-hand side 
of the window.
It will turn red when selected.

8. To stop capturing, click the square Stop button (it will turn blue when selected).  
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9. Right-click the clip and rename it. All captured video will automatically be stored in your 
project media area.

10. Close Video Capture window.

Capturing from VHS VCR
1. Ensure the fi rewire cable from the DV source is unplugged.

2. On the menu bar, select Project/Capture Video. A dialogue box 
     called Capture Video is displayed. Select DV. Select OK.

3. The Verify Tape Name dialogue box appears. Name your tape by typing into the File 
name fi eld, for example, Tape 01.

4. Below the tape name, select the fi rst option: Don’t capture any clips right now to 
manually start and stop the capture, select OK.

5. Click Play on the VCR to fi nd the beginning of your fi rst clip.

6. In the Vegas Capture Window, press the round Capture Video button (it will turn red 
when selected).

7. To stop capturing, press the square Stop button twice in the Vegas Capture Window (it 
will turn blue when selected).

8. Press Stop on the VCR. Repeat steps 4 to 7 to capture other video clips.

9. Right-click the clip and rename it.

10. Close the video capture window. Video will automatically be stored in your
      Project Media.

11. Select Project/Save.
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Import Media

To import photo, video or audio fi les
Photos (or stills) such as .jpg and others, video such as .avi, .wmv, .mpg and .mp4 fi les, 
as well as HD (High Defi nition) fi les, and audio such as .wav and .mp3 fi les, can all be 
loaded onto your computer, then imported into your Project Media area and used in your 
show.

Each computer has an internal card reader that supports CF I, CF II, MS, MS PRO, 
Microdrive, MMC, SD, SM, MS Duo, xD, miniSD, RS-MMC, and TransFlash.

 1. Minimize the Vegas software.

 2. Insert the memory card or USB drive containing the fi le you wish to import.

 3.A (G:) drive dialogue box opens

4. Select Open folder to view fi les.

5. Select and copy the fi le you wish to use. To copy, select the fi le and press Ctrl + C.

6. Double click on My Computer to open it.

7. Open the station1(F:) drive.

8. Open your previously created video folder, then open your Media folder.

9. Paste the fi le into your Media folder on the F: drive.

10. a) Select Safely Remove Hardware (green arrow icon located in lower right

          tray on your computer screen)

      b) Unplug your memory card or USB drive.

11. Maximize Vegas software.

12. In your Vegas software, select Project / Import Media.

13. Select the media fi le you pasted into your Media folder on the F: drive.

14. Select Open. The fi le is now located in Project Media.

The media you have now imported can be dragged from your Project Media 
area down to the editing timeline to be included in your show.
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Editing

When you fi rst open a Vegas project, the cursor appears at the beginning of the Timeline. The 
position of the cursor within the Timeline determines where your video starts playing. Before 
you add a video clip to the Timeline, you must fi rst trim your video to get the proper In and 
Out points.

To start:

1. In Project Media, double click the 

 video clip you want to edit. 

 It will load into the Trimmer.

    The Trimmer is used to select specifi c

    In and Out points for the video that will 

    go into your timeline.

2. Hold down the left mouse button and highlight the section of the clip you want in your 
production by dragging the mouse to the right. Watch your software preview monitor 
when making your selection.

3. Once you have created this highlighted section, move the mouse to the left hand side of 
the selection. The cursor changes to a double arrow. Drag the cursor in or out to fi ne tune 
your video In point. The video In point is the beginning of the shot that you want your 
audience to see.

4. Place the cursor on the right hand side of the selection. The cursor changes to a double 
arrow. Drag the cursor in or out to fi ne tune the video Out point. The video Out point is 
the end of the shot that you want your audience to see.

5. Click the selected video and audio. Holding down the left mouse button, drag the selected 
clip down to the Timeline. (Make sure both audio and video are highlighted in blue.)

Each video and audio clip on the Timeline is called an Event.

Editing within the Timeline
The square bracket keys on your keyboard,  [   ],   allow you to move to the beginning and 
the end of a clip. The left bracket key moves the cursor to the beginning of a clip, the right 
bracket key moves the cursor to the end of a clip. A tall, fl ashing line - the cursor - indicates 
your position on the Timeline.

1. To access a point within a clip, move the mouse pointer to the desired position and click. 
    The cursor will move to this position. You can now select Play.
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2. To watch your video clip, go to the beginning of the clip and select Play.

3. If further adjustments need to be made, place your cursor over the left or right edge of your 
video clip. The cursor changes into a double-headed arrow.

4. Hold down the mouse button and drag the edge of your video clip to the left or right. This 
will add or remove video footage from your Timeline, changing your In or Out points.

5. Watch your preview monitor as you drag the clip. This will help you to decide your new In and 
Out points.

Dragging your clip too far to the right will cause the clip to freeze on the last frame of captured 
video.

Inserting a Video Clip
At times you will want to add video without disturbing your audio tracks. To insert a video 
clip over top of another video clip:

1. Open Project Media and double-click the video clip you wish to insert in order to

    open it in the Trimmer.  

2. Use pre-existing track labelled Video Overlay.

3. In the Trimmer, select the exact segment of the video clip you wish to insert.

4. Drag the selected segment to the Video Overlay track.

The uppermost track within your timeline is always the one shown.

Inserting Time into the Timeline
Non-linear editing allows you to insert space into your Timeline. For example, you may have 
fi nished your show and then realize you need to add a new piece to the beginning or middle of 
your project. Note: If a cursor is placed in the middle of an event, the event will split.

1. Select the track you wish to insert time into, by clicking it once on the timeline .

2. Place the Cursor at the point where you want to insert time.

3. (Or press Ctrl-A to select all the tracks in your project).

4. Select Insert / Time. The Insert Time dialogue box opens.

5. Enter the amount of time you want to add to your project. For example, to add 10 seconds, 
type in 00:00:10:00.

6. Click OK.
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7. Add new event(s) to the created space.

8. To close any gaps between the new material and the rest of the project, select Auto Ripple 
from the task bar. Drag the fi rst clip of the old material to the left to join the new material. 
All other clips will follow.

9.Deselect Ripple Edit. (This step is crucial.)

Crossfades and Other Transitions

It is very simple to create a Crossfade between two video clips. If Automatic Crossfade is 
highlighted, crossfades are created automatically by overlapping the two clips. The more you 
overlap the clips, the more time will be used to do the crossfade. The average Crossfade is 
one to two seconds long.

As the clips touch, a tall, blue X appears in the overlapped portion of the video clip, indicat-
ing the Crossfade area. Other Transitions like wipes and barn doors can easily replace the 
crossfade. Simply follow the steps below.

Automatic Crossfade
1. Select Automatic Crossfade and Ripple Edit on the Toolbar.

2. Overlap the two clips by clicking and dragging the second clip on your timeline over top of 
the fi rst one. The more you overlap the two clips, the longer the fade.

3. To check the duration of the Crossfade on the status bar at the bottom right of the Timeline 
window, double-click the timeline where the audio or video overlaps. This highlights the 
crossfade. Three fi gures are displayed on the status bar at the bottom right of the timeline 
window:

a) The fi rst fi gure is the In point of the selected area.

b) The second fi gure is the Out point of the selected area. 

c) The third fi gure is the duration of the Crossfade.

4. Turn off Automatic Crossfade and  Auto Ripple by clicking them again.

Other Transitions
1. Follow the steps above for creating a crossfade.

2. Go to Transitions in the Windows Docking Area.

3. Select a new transition and drag and place it on the timeline on top of the current crossfade 
(to replace it).
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4. A dialogue box will open that allows you to make adjustments to the transition. Close the 
dialogue box after making adjustments.

5. To try other transitions, follow steps 2 to 4 until you fi nd one you like. 

Fade In / Fade Out
Fade Ins and Fade Outs work on all events: audio, video, stills and titles. An average fade is  
one to two seconds.

1. Move the mouse to the upper left-hand corner of an event for a Fade In or to the upper 
right-hand corner for a Fade Out. The pointer image turns into a quarter pie shape.

2. Click and drag toward the centre of the clip to create the fade. Once again, the farther you 
drag, the longer the fade. The duration of the fade is displayed in a yellow box beside the 
pointer as you drag. The duration changes as you resize the fade.

Titling: Text

Fonts
When selecting your font or type size, a 48-point minimum is recommended. Given that small 
type is diffi cult to read on television monitors we recommend using no more than 3 lines of 
text per title screen. Use sans serif fonts such as Arial or Verdana (rather than serif ones 
such as Times New Roman or Lucida. )

Colours
Video monitors and television monitors display colours differently. Certain colours do not 
look good on television, notably vibrant colours such as hot pink, bright red, and lime green. 

Contrast
Make sure your background colour contrasts with your titles. It is best to use dark coloured 
letters against a light background (e.g., deep blue text on white) or light coloured letters 
against a dark background (e.g., white text on black). 
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Title Safe Area
Keep your titles in the Title Safe Area. When typing your text in Vegas, view the Title Safe 
Area red box on the Placement tab. Titles or graphics outside the red box may be lost from 
view.

Create Titles Over Moving Video
1. Select the track ‘Text” already in track list. A blinking cursor appears.

2. In the Window Docking Area, select Media Generators. Select ‘Text’ in the left

   column then select a text preset in the right column.

3. Drag the text preset that you have selected to ‘Text’ track over the exact spot of the video 
    you wish to create a title over. 

4.Place the cursor at the beginning of your title in order to see it in the Preview Monitor..

5. Enter and edit your text in the Media Generator box that appears. Here you select font 
properties, title placement and effects.

6.  The title will appear in the Preview Monitor. .

7. Close the Video Media Generators box.

8.To edit the Title text, reopen the Video Media Generators box by clicking the top right-hand 
corner of the Title event’s Generated Media box.

Titling Fades
1. To Fade In your Title, place the cursor in the top left hand corner. The cursor changes to a 

pie shape with a double-headed arrow. The yellow opacity info box appears displaying the 
duration of the fade. Click and drag the pointer to the right. You will see the duration of the 
Fade In in the opacity info box. (An average Fade In is one to two seconds.)

2. To Fade Out your Title, place the cursor in the top right hand corner. The cursor changes 
to a pie shape with a double-headed arrow. The opacity info box appears displaying the 
duration of the fade. Click and drag the pointer to the left. You will see the length of the 
Fade Out in the opacity info box. (An average Fade Out is one to two seconds.)

Credit Roll

Creating a Credit Roll Over Moving Video
1. In the Window Docking Area, select Media Generators.

2. On the left hand side, select Credit Roll. Preset options appear on the right.
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3. Click and drag Scrolling on Transparent into the Title Track on the Timeline. 

    Place the Credit Roll event on

    the Text title track above the video clip 

    where you want the Credit Roll 

    to appear. 

NOTE: 

A common mistake is placing the

 Credit Roll on the same track

 as the video. Doing this will cause the

 Credit Roll to replace the video.

4. Place your cursor over the beginning of your Credit Roll in order to see it in the Preview 
    Monitor.

5. Close the Video Media Generators box.

6. To edit the Credit Roll text, reopen the Video Media Generators box by clicking the top 
right-hand corner of the Credit Roll event.

7. Select Project/Save.

Slow Down the Credit Roll
Once you have positioned your Credit Roll in the Timeline:

1. Hold down the Ctrl key, click the right edge of the credit roll clip, and drag it to the right.

2. Drag the clip out to the desired length.

NOTE: The credit roll will not display smoothly until rendered. You can render now or at the 
end of your project. (See Selectively Prerendering Video Effects.) 

If Credit Roll is Looping (repeating)
1. Right-click the Credit Roll. A menu appears.

2. Select Properties at the end of the list. The Properties dialogue box opens.

3. Select the Video Event tab (if necessary).

4. Deselect the Loop option.

5. Click OK.
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Rendering

Any fade, special effect, or title requires rendering. This is the process of creating each frame 
of an effect so that it plays back smoothly in the Timeline. When you fi nish your show and 
export it to tape, Vegas will render all unrendered effects in your show before creating a DVD 
or starting to output to videotape.

Vegas previews unrendered effects in lower quality form. This is helpful for previewing your 
effect. If you are not satisfi ed, you can selectively prerender your video effects as you work. 
Rendered effects play at full quality.

Selectively Prerender Video Effects
To render temporary preview fi les for the section of your show that contains an effect, for 
instance, title, fades, or slow motion:

1. Select the area of your show that you want to preview. (If no time is selected, the entire 
show on the Timeline will be used.)

2. Place the cursor on the grey Timeline Marker Bar (above the Time Bar) at the beginning of 
the video segment you want to render. Click and drag until you have highlighted the entire 
segment.

2. From the Tools menu, select Selectively Prerender Video. The Prerender Video dialogue 
box appears. 

3. From the Prerender As drop down list, select Video for Windows (*.avi), if it is not 
already selected.

4. Click the Render loop region only option.

5. Click OK. The rendering process begins, and a progress box appears.

6. When completed, a blue bar appears at the top of the Timeline to indicate each rendered 
section.

7. Select Project/Save.
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Audio

The Video/Audio Stations work with three kinds of audio: narration, music from CD, and   
the audio that comes automatically with video. 
To listen to your audio: 
1. If only one person is editing, use the USB headset with microphone. 
2. If you need a second person to hear the audio played back:
    a) Unplug the USB headset with microphone and 
    b) use the two standard headsets (located on the desk)
    c) if you get an error message select Project/Save and continue. Headphones will work.

Audio Levels
As you edit, be aware of your audio levels. 
a) View audio levels in the Mixer Window at the top centre of the screen,.
b) If you don’t see it click on the Mixer Window tab. 
c) The Mixer Window’s volume slider should be set around 18, and audio tracks should be 
    adjusted so that the numbers at the top do not go above 0.0 for the duration of your project. 
d) Audio adjustments are made within individual audio tracks.

Adding Narration
Prepare to Record

1. To create a new Audio Track: On the Menu bar, select Insert /Audio Track.
2. Right-click the new Track and select Rename. The name box on the Track turns white and    
   a blinking cursor appears. Enter Narration in the track’s Name fi eld.
3. Arm (prepare) the track for recording by selecting the round Arm for Record button in 
   the Track.
4. You will see a speaker icon on the audio track. 
   a) Left click on the icon.
   b) Select the left speaker option.

Adjust the Headset Microphone

1. Ensure the USB headset with microphone is plugged into USB port.
2. Talk into microphone and adjust Volume slider on audio track (left) to the desired volume.

Record Narration in Vegas

1. Talk into the microphone, checking audio levels on the Narration Track List as you speak.           
   A green LED display appears in the Audio Track of the Track List.
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2.As you talk, adjust the levels until you get a level between 15 and 3 (around 12). 
3. Staying within the narration track, move the cursor on the Timeline to the point where you 
   want your narration to start.
4. On the Timeline Transport Bar located below the timeline, click the Record button to 
   begin recording.
5. To stop recording, click the Record button again, or click the Stop button on the Transport 
   bar. The Recorded Files dialogue box is displayed.
6. In the Recorded Files dialogue box confi rm the fi le name and location of your recorded 
   audio.
7. Click Rename to change the fi le name or click Delete or Delete All if you do not want to 
   save the recorded fi les.
8. Click Done. Your recorded fi le is displayed as a new Event in the timeline and it is added 
   to the Media Project.
9. When all narration is fi nished, select the Narration Track List and click the red Arm for 
   Record button to deselect. 
10. To view the volume levels of your audio track(s), view the Master audio Mixer Window. 
11. Select Project/Save.

Extracting Audio (Music) from a CD
1.Insert a music CD into the top CD-ROM drive. A dialogue box opens with options, click 
   cancel.
2.Within Vegas, on the menu bar select Project /Extract Audio from CD.
3.Select the music track you want to add by selecting Play to listen to the track.
4. Select OK to import the track into Vegas. The Save As window opens.
5.Enter the fi le name, and ensure it is saved to station#F:drive/project name/media folder. 
    The audio will be extracted, saved, and put into your Project Media.
6. In the Trimmer, select the music segment you want in the same way you trimmed a section 
    of video earlier. 
7. Drag the music fi le from Trimmer to the Music Track.
8. If you need only a small portion of music for your production, double-click the music fi le        
    in the Media Project to open it in Trimmer. 
9. Select Project/Save.

Automatic Audio (audio from the videotape)
The third type of audio is the audio that comes when you capture your video. When you add 
video that contains audio to the timeline, an audio track called Voice is automatically utilized. 
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Adjusting the Volume Within the Audio Track
Adjust the volume by adjusting individual audio events. Within each audio clip, you can 
adjust the volume for the whole clip, or for portions of the clip. For instance, you may have a 
music track that you want to be louder when the title sequence appears and then fade into the 
background when your narrator is speaking.

To adjust the volume for a whole event:

1. Select the Audio Event that you want to adjust.

2. Select Shift + V. A blue line appears in your Audio Event.

3. When the mouse pointer is over the blue line on the audio clip, it will turn into a pointing 
hand. Click the blue line to drag the volume of the whole audio clip up or down.

To adjust portions of an event, you will fi rst need to Add Points. A point is a marker on the 
Audio Track that indicates where you want your audio volume to change. 

1. Click the blue line. 

2. When the cursor turns into a pointing hand, you can double click to Add Points or you 
can right-click the Audio Event to select Add Points. Vegas will add a point wherever the 
cursor is placed. 

3. When all your points have been added, you can make adjustments by clicking and    
 dragging the points to move them up or down. (Four points are required for each change.)

4. To delete an inserted point, right-click the point and select Delete.

It is also possible to raise or lower the volume level of all Audio Events in your show by 
moving the Vol (volume) Slider. However, this method is not recommended, as it will make
a global change throughout the audio track.

Narration Volume

The most important audio for educational videos is narration. To properly mix your narration 
with background sounds and music:

1. Find a narration audio clip on the timeline.

2. If music and /or background sounds are playing at the same time as the narration, mute   
 those channels using the mute button located on their Track.

3. Adjust narration audio levels: refer to Adjusting the Volume Within the Audio Track   
 (see above).

4. Unmute background sounds and adjust the audio levels so that background sounds are   
 barely audible when narration is playing.

5. Unmute music and adjust the music levels ensuring they don’t compete with narration.
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Locking Volume Points to Audio Event
If you have added volume points to audio and then want to move the clip earlier or later on 
the timeline, make sure that in the menu bar, Options/Lock Envelopes to Event is selected. 
The points will then move with the clip.

Changing the Speed of a Video Clip

There are two ways to control the speed of a video clip. The fi rst method adjusts the speed of 
the entire clip; the second method allows you to change the speed of a clip at specifi c points 
in the clip.

Adjusting the Entire Clip
1.  Point at the end of the selected video clip until a double-headed arrow appears.

2.  Press and hold the Ctrl key on the keyboard. A squiggly line appears under the double-  
 headed arrow.

3.  Still holding down the control key, click and drag the video clip to the right until it is 
 the desired length. Drag the clip to the right to slow it down, or to the left to speed it up.   
 The farther you drag it, the slower or faster the motion of that clip, depending on whether   
 you dragged it right or left. In the clip on the timeline, a wavy line between the images   
 indicates that the clip has been stretched.

Freezing a Video Frame in the Middle of a Clip
You may want to freeze a video clip at a specifi c point so the narrator can talk about some-
thing on screen and resume playing when you have fi nished. To freeze a frame:

1.  Position the Timeline Cursor on the video frame you want to freeze. (You can use the   
 left and right arrows on your keyboard to move the cursor one frame at a time.)

2.  Press the letter S on your keyboard to split the video clip into two clips. Do not move cursor.

3. Change the preview mode to Best (Full). The Preview mode is located above the Vegas 
internal Preview Monitor. 

4. Deselect the Television icon (Preview on External Monitor) located above the Vegas 
internal preview monitor. This will change the preview from external monitor to the 
internal preview monitor.

5. Click the Save Snapshot to File button. This button looks like a fl oppy disk, and is located 
just above the preview screen. The Save Snapshot to File dialogue box opens.

6. Ensure you save the snapshot to the New Volume F:drive/Rendered Media/and name the 
fi le. Click Save, and the fi le is automatically imported into your Project Media.
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7. Go back to the Timeline. Drag the second half of the spilt clip to the right, opening a space 
for your freeze frame.

8. From the Project Media, drag the saved Snapshot to the opening in the timeline. Adjust the 
Snapshot to the desired length.

9. Drag the second half of the split clip and nudge it up to the end of the freeze frame.

10. When you have fi nished, return the Preview mode to Preview (Auto).

Your video will now play, freeze for the desired length of time, and then continue playing to 
the end of the clip.

Capturing a Single Frame of Video

Creating a Single Frame Snapshot
1. Position the Timeline cursor on the video frame you want to freeze. Use the left and right 

arrows on your keyboard if you want to move the cursor one frame at a time.

2. Change the preview mode to Best (Full). The Preview Mode is located above the Vegas 
Internal Preview Monitor. 

3. Deselect the television icon (Preview on External Monitor) located above the Vegas 
Internal Preview Monitor. This changes the preview to the internal preview monitor.

4. Click the Save Snapshot to File button. This button looks like a computer disk. It is 
located just above the preview screen. The Save Snapshot to File dialogue box opens.

5. Save the snapshot to New Volume F/your project name/Rendered Media, name the fi le 
and click Save; the fi le is automatically imported into the Project Media.

6. Add the clip to the timeline and adjust it to the desired length.

7. Right-click the clip and select Properties. Then select Reduce Interlace Flicker.

8. When you have fi nished, change it back to the previous setting, probably Preview (Auto).

Playing a Video or Audio Clip in Reverse
1. Place your clip on the Timeline.

2. Right-click the clip and select Reverse from the short cut menu

3. An arrow will appear at the beginning of your clip to show you which direction your clip is 
playing.

4. To resume normal direction play of clip, right click on your clip and select Reverse again       
    for normal play.
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Exporting / Recording Your Show

Copyright and Backup Your Show
1.If you create a completely original show, copyright your work. At the end of the credit roll  
   write: “Copyright _____ (current year) _____ (your name)”

2. Backup all your project fi les onto your own USB Flash drive or external hard drive. 

Preparing to Export
Before exporting your show, play your program while watching your master audio levels. 
View audio levels in the Mixer Window. At no point in your show should the audio levels go 
above 3. Above 3 the audio may distort. If too low, the audio level will be diffi cult to hear.
Do not adjust audio levels in the Master Mixer. Adjust the volume of each track individually.

Exporting  
This is the fi nal stage of completing the show. You are fi nished everything: editing video, 
music and narration. You have viewed your fi nal show, and it is perfect. You are now ready to 
record it in a chosen format.
NOTE:  Save your project before exporting it. Select Project > Save.

Burn to DVD

1.  Place blank DVD in computer DVD burner slot. If a dialogue box appears, close it.

2.  In menu, click on Project > Make Movie, or, select Make Movie in tool bar.

3.  In Select Destination dialogue box, select Burn it to a DVD, Blu-ray Disc or CD.

4.  Click Next>.

5.  Select DVD.

6.  Click Next>.

7.  Make sure your video and audio
     fi le path is correct. See image:
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8.   Click Next>.

9.   If a dialogue box comes up asking you if .you want to over-write program already   
 existing, click Yes. A Rendering box appears. Your program is now rendering.

10.  When rendering is complete, a Make Movie - Completed dialogue box appears.
 Click Send to DVD Architect Studio.

11.  Close the Show Me How dialogue box.

12.  Highlight “Menu 1” and delete.

13.  Right click on Button and select Button style>Text only.

14.  Right click again on Button, Select Edit Text and name your movie.

15.  Click Make DVD on tool bar at top.

16.  Click Burn.

17.  Click Next>.

18.  Click Next>.

19.  Click Finish. (Make sure it is going to the correct drive - D:Drive). A dialogue box 
 displays the burning process. Wait for burning to complete. 

20.  A dialogue box appears asking if you want to burn another, if burning just one DVD,   
 select No.

21.  Exit from the Sony DVD Architect Studio 4.5 Program.

22.  Click No for saving changes.

23.  The Make Movie - Completed dialogue box appears. Click Cancel.

24.  Manually name your DVD. A sharpie pen will usually write on any DVD disk.
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Render for Podcast/I Tunes University

1. Click on Make Movie in tool bar.

2. Click on Save it to my hard drive.

3. Click Next.

4. Click Advanced Render button.

5. Make sure your settings are correct:

 

 a) File name: (your show)

 b) Save as type: Main Concept AVC/AAC (*.mp4)

 c) Template: Apple iPod 640x480 Video

6. Click Save.

    A Rendering dialogue box appears. Wait for rendering to complete.

7. Click Open.

Your new .mp4 fi le is on the F: drive in your Project/Renders folder.
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Render for Power Point/Mediasite
 1. Click on Make Movie in tool bar.

 2. Click on Save to Hard Drive.

 3. Click Next.

 4. Select File Path Browse button. Select your F:drive folder.

5. From Format drop down menu, select Windows Media Video V11.
    A pop up window appears showing rendering status. Be patient, rendering takes time.

 6. Click Next.

 7. Click Finish.

 8. Your project’s new .wmv fi le will appear in your F: drive project folder.
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Vegas Preferences

These preferences determine the characteristics of your video and audio, and direct your 
project and associated media to the F:drive.

Project / Properties 
Video tab  

Audio tab
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File Folder  

     

Shutting Down

Close Software and Power Down Computer
1.  Click Start/Shut Down.

2.  Open the drop-down menu, select Shut Down, and click OK.

Turn Off All Equipment
Turn off TV, VCR, and computer monitor.
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  Troubleshooting

Equipment Issues
Ensure that all equipment is plugged in and turned on:

1. Turn on the computer.

2. Turn on the VHS VCR, and select output L1 (Line 1).

3. If a miniDV camcorder is being used, it must be plugged into the AC adaptor, and the 
fi rewire cable must be plugged into the camcorder and into the computer.

4.  Turn on the TV monitor.

5.  Headset microphone should be plugged into computer USB input.

6. Headphones should already be plugged into the back of the computer. If not, ask a CLS 
staff member to plug them in.

Computer Issues
I can’t log on…

 Login 1

 Username:  station1 or station2 or station3 (depends which one you are using)
 Password:  no password

                     Work station only

 I can’t fi nd the fi les I worked on last week…

1. All project fi les should be saved to the station1 (F:) drive.

2. The fi les may have accidentally been saved to the C: drive of the computer you were 
working on previously. Perform a Search to fi nd them: Start>Search.

Video Issues
I can’t see the video image in my monitor…

1. Ensure the TV Monitor is turned on.

2. Ensure the VCR is turned on.

3. The Input Select button on the VCR must be set to L1 (Line 1).

4. The Vegas Preview to External Monitor button must be selected.
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5. On the TV monitor you must manually select the TV/Video button to switch to video mode.

6. In Vegas, check the Track List and ensure that the Mute function has not been activated. If 
so, press the Mute icon to deactivate.

7. Unplug the fi rewire to MiniDV Camcorder. You will not be able to see your show in the TV 
Monitor if a MiniDV Camcorder is still plugged into the fi rewire.

One video clip on my Timeline seems darker than normal, or black.

You may have accidentally activated the opacity of the video clip. Look for a white line pass-
ing through the clip on the Timeline. Place your cursor on the white line. Hold down the left 
mouse button and drag the white line to the top of the clip. It should now read the opacity as 
100%.

I can’t record onto VHS tape…

1. Check to ensure the video record tab is intact on the videotape.

2. Is the VCR turned on?

3. Input Select on the VCR must be set to L1 (Line 1).

4. You must manually select the Record button on the VHS VCR to record onto VHS. 

 I can’t capture from the MiniDV camcorder…

1. Ensure the MiniDV camcorder is turned on and is in VCR mode.

2. Ensure one end of the fi rewire cable is plugged into the MiniDV camcorder and the other 
end into the computer.

I can’t capture from the VHS VCR…

1. Ensure the VCR is turned on.

2. Ensure that the video RCA cable is connected to the line out of the VCR.

3. Ensure the other end of the video RCA cable is connected to the computer’s V-In input.

Audio Issues
I can’t hear my audio in the TV Monitor…

1. Audio can only be heard through the TV Monitor while the project is being output to tape.

2. While working on a project, audio can only be heard through the computer headphones.
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I can’t hear the audio out of the headphones… 

1. Ensure the USB headphone OR the two stereo headphones are plugged into the 
computer.

2. The computer volume slider must be up, and the mute check box unselected. 
(The computer volume icon is on the computer’s taskbar at the bottom of the 
screen, right of centre).

3. Check to see if the audio track is muted in Vegas.

4. Check headphone volume control.

5. Save your show, close it, and open it again. This will enable the correct headphone settings 
    in the computer and software.

I can’t record narration to my project…

1. Ensure the headset microphone is plugged into the computer USB input. 

2.  The computer volume slider must be up, and the Mute check box unselected. (The 
computer volume icon is on the computer’s taskbar at the bottom of the screen, right 
of centre).

3. In Vegas, the Audio Track volume may need to be turned up.

4. The Arm for Record button must be activated. 

5. Double check the instructions on page 21 above.


